Cellpro Multi4 Charger

Model LC04S04A-MC, for use with LiPo, Li-Ion, A123, NiCd, NiMH and Lead Acid battery packs

Automatic and manual charge rates at up to 4A with overcharge protection and cell balancing (for packs with node connectors)

Features

New in v1.55 firmware: Press and hold Mode button at power on (see page 7) to...
- Set current input limit to prevent charger from over-stressing power supply.
- Turn Auto Start on/off (off is factory default). With Auto Start on, simply connect battery to begin charging using selected preset.

New in v1.58 firmware: Multi4 now fully supports charging two parallel-connected packs using two chargers. See page 11 for details.

- Simple to operate: just connect the Cellpro Multi4 Charger between a power source and a pack, select a pack-specific preset and start charging. No jumpers, plugs or dials to set! Charger automatically determines pack capacity and sets optimal current, then dynamically adjusts charge rate as needed. Manual charge rates up to 4.0A allow for special situations.
- Charges LiPo, Li-Ion, LiFePO4, A123©, LiMn, NiCd, NiMH and Lead Acid chemistries (adapters for many node connector types are available from FMA Direct). Supports both balanced (depending on chemistry) and non-balanced charging (with certain safety limitations).
- Charger holds up to 25 user configurable presets (User Presets), optimized for the different chemistries, providing charging strategies for most common RC charging needs. Charger also holds up to 50 Library Presets. When using the free Charge Control Software, the number of custom presets is virtually unlimited and will grow over time to meet industry needs. Replace and customize presets to match your battery inventory.
- Charges Lithium (2s to 4s balanced charge, 1s to 2s unbalanced charge) and A123 packs (2s to 4s balanced, 1s to 5s unbalanced) in any capacity up to 32Ah. During balanced charging, each cell is charged independently, providing exceptional charging safety and elevating RC packs to the safety level of cellphones. Typical packs of up to 4Ah capacity charge in 50 minutes or less using charger’s 2C Auto Current Mode.
- Latest technology provides the ultimate in safety—even charges packs having hidden physical damage without danger of fire. A pack will not charge if individual cell voltages don’t equal total pack voltage.
- Cell balancing to 5mV and automatic overcharge protection assure longest pack life. Automatic temperature monitoring prevents pack overcharging at low ambient temperatures and charger damage at high ambient temperatures.
- Backlit display lets you select presets, replace default presets from a library and shows charging data such as individual cell voltages, charge current, supply voltage, and amount of charge (mAh) put into pack. Plus, the unique Fuel display shows percent capacity in a pack.
- Charge Control Software (CCS, a free download) allows you to customize, save and load presets (including charger data displays), and view real-time charging data and graphs. CCS also manages firmware updates to keep your charger operating smoothly.

Precautions

- Follow all instructions in this manual to assure safe operation.
- Always watch LiPo packs while charging. Never leave them unsupervised during charging.
- See additional warning sheets provided with this charger and FMA LiPo packs.
- Follow all guidelines for charging, discharging, handling and storing packs of all kinds.
Connecting the charger

Connecting packs with a Cellpro connector

Connect packs as shown in this diagram:

Optional connection to PC using FMA FUIM2 or FUIM3 cable
Connect to 10–16 VDC (e.g., gel cell or power supply)

To charge two packs that are connected in parallel, using two Multi4 Chargers, follow the instructions on page 11.

CAUTION: When two LiPo/Li-Ion/A123 packs are connected in series, do not connect them to two separate chargers that are wired to a single power source. The single power source provides a common ground to both packs, and the result is a direct short across one of the battery packs if charging were to start. The Multi4 Charger contains protective circuitry that prevents it from starting a charge when it detects this situation. However, one or both chargers, as well as the packs, could be damaged. This condition can be avoided if the chargers are driven from two unconnected power sources (e.g., two lead acid batteries). For safest charging of series-connected packs, disconnect the packs from each other before connecting them to chargers.

Connecting non-Cellpro packs

FMA Direct offers plug-and-play adapters for charging LiPo/Li-Ion/A123 packs equipped with node connectors made by other vendors. Check the Cellpro section at www.fmadirect.com for the latest adapters.

If an adapter isn’t available for the pack you want to charge, or if the pack doesn’t have a node connector, the FMA CPBP7 LiPo Pack Node Connector cable assembly will make the pack compatible with the Cellpro Multi4 Charger. The diagrams below show how the Node Connector attaches to packs of various configurations. Additional assembly information is provided with the Node Connector.

* Nominal voltage with respect to pack negative.
Charging a pack

As shipped from the factory, the Multi4 Charger is equipped with 20 User Presets optimized for common battery types, plus five Empty Presets. In many cases, you can simply select the User Preset that matches the pack you want to charge, connect the pack and start charging.

User Presets cover LiPo, Li-Ion, A123, NiCd, NiMH and Lead Acid chemistries paired with commonly-used charging strategies. (If the User Presets aren’t quite what you need, see the instructions beginning on page 6.) The charger also includes a Preset Library containing up to 50 presets. A Library Preset is like a User Preset, except that it must be loaded into the User Preset bank before it can be changed and used for charging (see “Loading a Library Preset,” later).

1. Connect the charger to a 10V to 16V (maximum), 5A power source.

2. After the Welcome screen (Cellpro Multi4) times out, you’ll see the Preset Menu.

   Tip: More information about the display—and how to navigate it—is provided on the next page.

3. The Preset Menu displays last User Preset you used. If this is the User Preset you want to use to charge the pack, go to step 4.
   otherwise
   Press the Mode button until the User Preset you want is displayed (see “Factory-installed User Presets” for descriptions). (If you see EMPTY PRESET, press the Mode button to go back to the beginning of the list.)

   Tip: Quickly press and release, press and hold, then release the Mode button to reverse the sequence of items being displayed in the Preset Menu. The tone indicates which direction you are going: high tone for forward, low tone for reverse.

4. Connect the pack to the charger.

5. If Auto Start is OFF (factory default), press and hold the Mode button. This displays the Operations Menu, which cycles through several screens. When you see START, release the Mode button. The display will briefly show CHECKING PACK.
   otherwise
   If Auto Start is ON (see page 7), go directly to step 6.

6. The next screen displays the preset’s chemistry (for example, LiPo) and prompts you to verify it is the same as the pack’s chemistry (which should also be, for example, LiPo). This safety check is your chance to prevent charging if the preset and pack don’t match.
   ■ If the displayed chemistry matches the pack’s chemistry, press the Mode button to start charging. Go to step 7.
   ■ or
   ■ If the displayed chemistry does not match the pack’s chemistry, do nothing—the screen will time out. At the prompt, press the Mode button to see the Preset Menu. Go to step 3.

7. During charging:
   ■ Press the Mode button to view various charging data screens (the number of screens and the data displayed depends on how the User Preset is configured).
   ■ To stop charging:
     a. Press and hold the Mode button. You’ll see Stop Charge? >No.
     b. Press the Mode button to see Stop Charge? >Yes. Press and hold the Mode button.
     c. You’ll see CHARGER STOPPED. Press the Mode button to go to the Preset Menu.

8. When charging is complete, the charger will “beep beep beep” several times and the display will show ELAPSED [time] / [chemistry] DONE. Press the Mode button to review charging data screens.

9. Disconnect the pack from the charger. The screen displays PACK REMOVED.

10. Press the Mode button to return to the Preset Menu. The charger is ready to charge another battery (step 3).
Navigating the charger’s screens

This diagram will help you understand how to move from screen to screen using the **Mode** button. There are four basic things you can do with the **Mode** button, as indicated in the diagram:

- **Press**: press and release the **Mode** button. In most cases, the next screen is displayed.
- **Press & Hold**: press and hold the **Mode** button.
- **Release**: release the **Mode** button after you press and hold it.
- **“Reverse Press”**: Quickly press and release the **Mode** button, then press and hold it, then release it to reverse the sequence items are displayed in certain lists (high tone = forward, low tone = reverse).

---

**Preset Menu**

- **[Last-used user preset]**
- **[next preset]**
- **[next preset]**
- **[next preset]**

**Operations Menu**

- **START CHARGE**
- **CHOOSE CHG. RATE**
- **CLEAR PRESET**
- **PRESET LIBRARY**
- **EXIT**

---

**Note:** Operations selected in **Operations Menu** apply to preset selected when you **Press & Hold** in **Preset Menu”**

---

If Auto Start is ON, simply connect pack to charger to begin charging with selected preset (see page 7 for Auto Start configuration details).
Charging

**CHECKING PACK**
- Press to Verify
- MODE not pressed
- Push to Reset

**[chemistry]**
- Press for info.
- [various charge data screens]

**STOP CHARGE?**
- Yes
- No

**STOP CHARGE?**
- Yes
- No

**CHARGER STOPPED**
- Press & Hold

**CHOOSE CHG. RATE**
- Charge @ [value]
  - Press for next value
  - "Reverse Press" to reverse sequence

**Choose Charge Rate**
- Apply selected charge rate to preset selected in Preset Menu

**Choose Preset from Library**
- [library preset]
  - Press
- [next preset]
  - Press
  - Etc.
- [last preset]
  - Press

**Note:** Press & Hold when desired Library Preset is displayed.

**Replace Preset from Library?**
- >N
- >Y

**Overwrite preset selected in Preset Menu with selected Library Preset. or Create new preset if EMPTY PRESET was selected in Preset Menu**

**Pack Removed**
- Disconnect pack from charger

**Note:** Press ONLY if displayed chemistry is same as pack chemistry

**Charge complete**
- Press & Hold

**Elapsed [time]**
- Press & Hold

**[chemistry]**
- Press & Hold

**DONE**
- Charging

**Charging complete**
- Disconnect pack from charger
Changing a User Preset’s charge rate

You can change the charge rate for any User Preset. The new rate is retained (even after power is cycled) until you change it again (this behavior can be changed via Charge Control Software).

1. Navigate to the Preset Menu.
2. If the User Preset you want to change is displayed, go to step 3.
   otherwise
   Press the Mode button until the preset you want is displayed.
3. Press and hold the Mode button. This displays the Operations Menu, which cycles through several screens. When you see CHOOSE CHG. RATE, release the Mode button.
4. The display now shows the preset’s charge rate (on the bottom line).
5. Press the Mode button to cycle through available charge rates (some rates are currents [A or mA], others are multiples of pack capacity [C]; the list wraps around).
   Tip: Quickly press and release, press and hold, then release the Mode button to reverse the sequence of charge rates. This enables you to go back to a rate, rather than running through the entire list. The tone you hear when you press the Mode button indicates which direction you are going: high tone for forward, low tone for reverse.
   Tip: Currents change in 5mA increments for small packs, and in 0.250A increments for large packs (depending on how presets are configured).
6. When the charge rate you want is displayed, press and hold the Mode button. This applies the charge rate to the preset and returns you to the Operations Menu.
7. In the Operations Menu, release the Mode button when you see the operation you want.

Clearing a User Preset

You can remove User Presets you don’t need. For example, if you don’t regularly charge A123 and Lead Acid batteries, you can remove those to limit the Preset Menu to the presets you do use. The first 20 presets in the Preset Library are the same as the 20 factory-installed User Presets (see list and descriptions later in this manual), so you can easily restore any presets you remove.

1. Navigate to the Preset Menu.
2. If the User Preset you want to remove is displayed, go to step 3.
   otherwise
   Press the Mode button until the preset you want is displayed.
3. Press and hold the Mode button. This displays the Operations Menu, which cycles through several screens. When you see CLEAR PRESET, release the Mode button.
4. You are prompted to confirm your action with the message CLEAR PRESET?. Press the Mode button to switch between confirming the removal (Yes) or denying the removal (No).
5. When you have selected the desired response to the prompt, press and hold the Mode button.
   If you selected Yes in step 4, the preset is deleted.
6. You are returned to the Operations Menu. Release the Mode button when you see the operation you want.
   Tip: If you are using the Charge Control Software, you can shorten the Preset Menu by hiding User Presets you don’t use, as well as hiding Empty Presets. See “Configuring User Presets,” later in this manual.
Other User Preset operations

- **To remove a User Preset:** See “Clearing a User Preset.” Thereafter, that slot will show EMP-TY PRESET until you load a Library Preset into it.

- **To load a Library Preset into any slot:** See “Loading a Library Preset.” If the slot was empty, this will create a new User Preset; if the slot already had a User Preset, this will overwrite it.

- **To back up / restore presets using the Charge Control Software:** See “Working with files.”

Strategies for organizing User Presets

Suppose all your packs can be handled with a small group of User Presets, and you don’t need any of the other User Presets (at least not now). What’s the most efficient way to organize your core presets?

- If you aren’t using the Charge Control Software: Follow the instructions in “Loading a Library Preset” to put your core presets in adjacent slots. Use the instructions in “Clearing a User Preset” to remove the User Presets you don’t need. Now, when you move through the Preset Menu on the charger, use the “reverse press” technique when you see EMPTY PRESET in the display—that will let you quickly move forward and back through your core presets.

- If you are using the Charge Control Software: In the Presets tab, drag the presets you want to the top of the list. For the presets you don’t need, set their visibility to Hide. Finally, click Update Charger. Now, only your core User Presets will appear in the Presets Menu. (Details are in “Using the Charge Control Software.”)

Configuring input current limiting and Auto Start

Press and hold the Mode button while applying power to the charger to access the Config Menu.

- **CHOOSE SPLY AMPS** limits how much current the charger draws from the power supply.

- **USE AUTO START:** Yes enables you to start charging using the selected preset simply by connecting the pack. No requires you to start charging using the START CHARGE screen in the Operations Menu.

(These can also be set via the Charge Control Software.)
Basic LiPo preset can be used for any LiPo battery. Fuel Table is optimized for generic LiPo batteries from C discharge ratings up to 20C. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for the most accurate charging with termination settings of C/20 and max of 30 min timeout for C.V. mode. This preset requires that every cell in the battery is charged to exactly 100%. If using high C rate discharge batteries (25C and higher), Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 1C AUTO.

2 LiPo Generic Faster Charge. Basic LiPo preset can be used for any LiPo battery. Fuel Table is optimized for generic LiPo batteries from C discharge ratings up to 20C. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for faster charging with termination settings of C/10 and max of 5 min timeout for C.V. mode. This preset does not require that every cell in the battery is charged to exactly 100%. If using high C rate discharge batteries (25C and higher), Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 2C AUTO.

3 LiPo Generic Long Life (4.1v). Basic LiPo preset copied from Preset 1 above but with end-charge voltage reduced to 4.1v. Use this preset if you wish to have the longest life from your LiPo batteries, but be aware, your flight times will be reduced slightly. Fuel Table is optimized for generic LiPo batteries from C discharge ratings up to 20C. This preset has termination characteristics similar to Preset 2 above for faster top off.

4 LiPo Generic Small Balanced. Special LiPo preset designed for charging small batteries but still using balance connector. This preset is recommended for battery sizes as small as 5 mAh and up to 500 mAh. Preset requires manual charge rate settings of between 5 and 500 mA in 5 mA increments. Fuel Table is optimized for generic LiPo batteries from C discharge ratings up to 20C.

5 LiPo 1s/2s Small Non Balanced. Special LiPo preset designed for charging small Park Flier type batteries that are not equipped with balance connectors. Be cautious when charging any LiPo battery non-balanced. The charger is not capable of detecting imbalance between cells. Never charge unattended using this preset. Fuel Table is optimized for generic LiPo batteries from C discharge ratings up to 20C. This preset has termination characteristics similar to Preset 2 above for faster top off.

6 LiPo All Brands Storage Charge. Special LiPo preset designed to storage charge a discharged battery up to 3.86v per cell. This preset will only work if the battery is below the storage charge voltage when connected. Manual charge rate setting is required when using this preset and ranges from 0.25A to 4.00A. Default setting is 2.0A.

7 LiPo REVO Black Accurate Charge. Brand Specific LiPo preset similar in all regards to Preset 1 above, but with Fuel Table optimized for REVOLECTRIX “Black Label” batteries. If used with other brands, the Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 1C AUTO.

8 LiPo REVO Black Faster Charge. Brand Specific LiPo preset similar in all regards to Preset 2 above, but with Fuel Table optimized for REVOLECTRIX “Black Label” batteries. If used with other brands, the Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 2C AUTO.

9 LiPo REVO Black Long Life (4.1v). Brand Specific LiPo preset similar in all regards to Preset 3 above, but with Fuel Table optimized for REVOLECTRIX “Black Label” batteries. If used with other brands, the Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 2C AUTO.

10 A123 2300 mAh Accurate Charge. Optimized for balance charging A123, 2300 mAh battery packs (requires node wires on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for the most accurate charging with termination settings of C/20 and max of 30 min timeout for C.V. mode. This preset requires that every cell in the battery is charged to exactly 100%. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 4.0A manual.

11 A123 2300 mAh Faster Charge. Optimized for balance charging A123, 2300 mAh battery packs (requires node wires on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for faster charging with termination settings of C/20 and max of 15 min timeout for C.V. mode. This preset does not require that every cell in the battery is charged to exactly 100%. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 4.0A manual.

12 A123 2300 mAh Non Balanced. Optimized for non-balance charging A123, 2300 mAh battery packs (node wires not required on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for faster charging with termination settings of C/10 and max of 15 min timeout for C.V. mode. This preset is not capable of charging every cell in the battery to exactly 100% because it does not have access to individual cell voltages. Imbalance will be present at the end of charge; however, A123 cells are not
as sensitive to this problem. Nevertheless, charging A123’s using the balanced charge preset(s) is recommended whenever possible. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 4.0A manual. Because this preset is not restricted by the node connector, it can handle 1-5 cells of this battery type only.

13 **A123 1100 mAh Accurate Charge.** Optimized for balance charging A123, 1100 mAh battery packs (requires node wires on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for the most accurate charging with termination settings of C/20 and max of 30 min timeout for C.V. mode. This preset requires that every cell in the battery is charged to exactly 100%. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 3.3A manual.

14 **A123 1100 mAh Faster Charge.** Optimized for balance charging A123, 1100 mAh battery packs (requires node wires on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for faster charging with termination settings of C/20 and max of 15 min timeout for C.V. mode. This preset does not require that every cell in the battery is charged to exactly 100%. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 3.3A manual.

15 **A123 1100 mAh Non Balanced.** Optimized for non-balance charging A123, 1100 mAh battery packs (node wires not required on the pack). Fuel Table is optimized for this specific battery type and capacity. Selectable charge rates include 1C, 2C, 3C AUTO or 0.25A to 4.0A manual. Optimization is for faster charging with termination settings of C/10 and max of 15 min timeout for C.V. mode. This preset is not capable of charging every cell in the battery to exactly 100% because it does not have access to individual cell voltages. Imbalance will be present at the end of charge; however, A123 cells are not as sensitive to this problem. Nevertheless, charging A123’s using the balanced charge preset(s) is recommended whenever possible. This preset may also be used for LiFePO4 type batteries which have similar charge characteristics. When using LiFePO4 batteries, Fuel Gauge readout may not be accurate and AUTO charge rate may be higher or lower than expected. Default charge rate setting is 3.3A manual. Because this preset is not restricted by the node connector, it can handle 1-5 cells of this battery type only.

16 **A123 All Cptcy Storage Charge.** Special A123 preset designed to storage charge a discharged battery up to 3.35v per cell. This preset will only work if the battery is below the storage charge voltage when connected. Manual charge rate setting is required when using this preset and ranges from 0.25A to 4.00A. Default setting is 3.0A.

17 **NiCd Fast Charge with Trickle.** Basic NiCd Fast Charge with Delta Peak Cutoff and Trickle Charge. Requires manual charge rate setting of between 0.25A and 4.0A, with default value of 1.0A. Can charge from 1 to 12 cell packs. Fallback default setting is 8mV. Trickle charge rate is 1/20C of the charge rate setting. Charge will timeout in 4 hrs if peak is not reached. Trickle charge timeout is set for 1 Day.

18 **NiMH Fast Charge with Trickle.** Basic NiMH Fast Charge with Delta Peak Cutoff and Trickle Charge. Requires manual charge rate setting of between 0.25A and 4.0A, with default value of 1.0A. Can charge from 1 to 12 cell packs. Fallback default setting is 5mV. Trickle charge rate is 1/20C of the charge rate setting. Charge will timeout in 4 hrs if peak is not reached. Trickle charge timeout is set for 1 Day.

19 **NiCd/NiMH 24 Hr Trickle Charge.** Basic NiCd or NiMH 24 Hour Trickle Charge preset. Requires manual charge rate setting of between 5 mA and 300 mA with default value of 100 mA. Can charge from 1 to 12 cell packs. Trickle charge timeout is set for 2 Days.

20 **Lead 12v SLA or Gel Cell.** Basic Pb (Lead) preset for charging 12v SLA or Gel Cell batteries. Requires manual charge rate setting of between 0.25A and 4.0A, with default value of 4.0A. Charges 12v battery only. If you require a 6v charge, this preset is available in the charger library and can be copied into the user bank (see manual for instructions). Charge will timeout in 16 hours even if end charge voltage setting of 14v is not achieved.

21 **EMPTY PRESET.** May be populated with any preset from the charger library or the FMA PC library.

22 **EMPTY PRESET.** May be populated with any preset from the charger library or the FMA PC library.

23 **EMPTY PRESET.** May be populated with any preset from the charger library or the FMA PC library.

24 **EMPTY PRESET.** May be populated with any preset from the charger library or the FMA PC library.

25 **EMPTY PRESET.** May be populated with any preset from the charger library or the FMA PC library.
Loading a Library Preset

The Multi4 Charger is equipped with 50 Library Presets. A Library Preset (which you can’t change) is a starting point for creating your own User Preset (which you can change). FMA configures Library Presets with optimal charge characteristics for a variety of battery chemistries and charging strategies. You can replace an existing User Preset with a Library Preset, or—if your charger has less than 25 User Presets installed—you can create a new User Preset from a Library Preset. After you load a Library Preset into a User Preset slot, you change the charge rate as described earlier in this manual. When using the CCS, you can configure up to 80 charge parameters in each User Preset.

1. Navigate to the Preset Menu.

2. If the User Preset you want to replace with a Library Preset is displayed, go to step 3. otherwise

   Press the Mode button until the User Preset you want to replace is displayed.

   or

   If the charger has less than 25 User Presets, press the Mode button until you see EMPTY PRE-SET (this will enable you to create a new User Preset).

3. Press and hold the Mode button. This displays the Operations Menu, which cycles through several screens. When you see PRESET LIBRARY, release the Mode button.

4. The display now shows the first of several Library Presets. Press the Mode button to cycle through available Library Presets (the list wraps around).

   Tip: Quickly press and release, press and hold, then release the Mode button to reverse the sequence of items being displayed in the Library Preset Menu.

5. When you see the Library Preset you want, press and hold the Mode button, then release it.

6. You are prompted to confirm the replacement. Press the Mode button to switch between confirming the replacement (Y) or denying the replacement (N).

7. When you have selected the desired response to the prompt, press and hold the Mode button. If you selected Y in step 6, this copies the Library Preset to the Preset Menu, where it replaces the selected User Preset or creates a new User Preset.

8. You are returned to the Operations Menu. Release the Mode button when you see the operation you want.

Open architecture presets

The Multi4 Charger can be described as being "preset driven." All major aspects of its operation are defined as parameters at the preset level. The fact that you (for the most part) can set these parameters introduces the concept of "open architecture presets."

As an example of how preset parameters affect the charging process, each Auto mode preset includes a Fuel Table unique to a specific battery chemistry. When you select a User Preset for the REVO Red brand, for example, you are also selecting a Fuel Table tailored for that brand. The charger uses the Fuel Table to adjust current to maintain the specified C charge rate. Given a brand-specific Fuel Table, the Fuel Level display and Auto charge modes are highly accurate.

When preparing to charge a pack, the first step is to find the appropriate User Preset. If one doesn’t exist, you might be able to create a User Preset from the closest Library Preset. Or you might select a User Preset from the library available in the Charge Control Software (which enables you to load, select, backup and share presets). You can even create a new Fuel Table for any Li chemistry by starting and recording a 1C charge (temporarily using a manually set current), and applying the table to an existing User Preset.

FMA technicians will continually update the presets library, which is included each time you update the Charge Control Software. This library will be supported far into the future as new battery brands and chemistries are introduced.
Charging two parallel-connected packs using two chargers

Multi4 Charger firmware versions v1.58 and later allow for reliable charging when using two Multi4 Chargers to simultaneously charge parallel-connected battery packs.

The Multi4 handles charging of two packs wired in parallel. An example would be two redundant flight packs used in gas powered airplanes. Typical configurations would be, for example, two 2s A123 batteries wired in parallel, or two 4s or 5s NiMH batteries wired in parallel. In these types of installations, switch harnesses should break each of the positive (red) wires between the battery packs and the airborne electronics (the red wires are physically disconnected from each other) during charging, while the negative (black) wire stays connected. Charging both packs simultaneously requires two Multi4 Chargers connected to two separate power sources that do not have a common ground.

To charge two parallel-connected packs using two Multi4 Chargers:

1. Disconnect the two positive (red) wires between the parallel-connected packs. This is usually accomplished by independent switches.

2. Depending on the pack chemistry, connect either the node connectors of each of the packs or the main discharge wires to two Multi4 Chargers. If charging non-balanced, be sure to select a non-balanced preset (and remember for LiPo packs the Multi4 only supports up to 2s non-balanced charge at a maximum of 1A charge current; this restriction does not apply to NiMH or A123 batteries).

3. Connect the chargers to two separate power sources that do not have a common ground—two lead acid batteries, for example.

   **CAUTION:** AC power supplies often have a common ground through their AC plugs, and therefore cannot be used in this charging situation. Always perform a continuity check to assure the power sources used to charge two parallel-connected packs are not connected through their grounds or negative output terminals.

4. Follow the Start Charge instructions to initiate charging on one of the packs.

5. Within 10 seconds, initiate Start Charge on the other charger. Failure to start the second charger within 10 seconds could result in a Safety Code indicating “Series Charge” condition. If this occurs, cycle power to both chargers and try again.
Practical information about the Multi4 Charger

General information

- Because FMA's cell balancing technology monitors individual cells, you don't need to cool a pack before charging it. Go from flying to charging to flying again without waiting. FMA cell-balancing chargers are the only ones that can charge a pack immediately after discharge without damaging the pack.

- Cells in a pack have different voltages when they are discharged. The Multi4 Charger balances (equalizes) cell voltages while it is charging the pack.

- During charging, cells that charge the fastest are the weakest cells in the pack. At the end of charging, cells with the highest voltage are weakest. This happens because weaker cells have lower capacity, and they charge faster than stronger cells.

- If the Multi4 Charger displays LOW VOLT RESTORE, the pack was overdischarged during its last use. The charger will attempt to repair LiPo cells measuring between 0.5V and 2.7V, or A123 cells measuring 0V to 2.0V. To avoid additional damage to restored cells, do not overdischarge a repaired pack.

- By definition, end of life for a LiPo cell is when the cell can only be charged to 80% of its original capacity rating. The number of charge/discharge cycles a cell undergoes before reaching end of life depends on several factors, including cell quality, discharge rate, internal heat generated during use, and other parameters. Cells in an older pack may be more out of balance, but the Multi4 Charger will still balance them to within 5mV by the end of charge. For this reason, it may take longer to balance older packs. The charger may show FUEL=99% for several hours while it is balancing a high capacity (3Ah and up) “veteran” pack that is severely out of balance, but User Presets might be set to stop balancing after a preset time. Often, the last few millivolts of balancing take a very long time and do not significantly improve overall pack charge or performance.

Charging packs

- You can top off packs, or remove them when they are partially charged. There is no way to damage a pack when using the Cellpro Multi4 Charger.

- If a pack is at 80% or less of its capacity when connected to an auto-detect speed controller, the controller may lower its cut-off voltage. This could overdischarge the pack during the flight. Auto-detect speed controllers should properly set cut-off voltage if packs are charged to at least 90%.

- To save time, stop charging when the pack reaches about 95% of capacity. That last 5% takes the longest. By default, User Presets notify you with two beeps when a pack reaches 90% of capacity (that threshold can be easily adjusted using the Charge Control Software).

- Some cells may sag 0.10V within an hour after charging. This is normal as packs age.

- When charging an A123 pack that has been discharged very low, the charger initially may not be able to accurately count cells in the pack. To eliminate the possibility of an inaccurate count, the charger applies current to “wake up” the cells, then recounts.

- Overdischarging an A123 pack below 2.0V/cell will damage the cells (contrary to some reports). The Cellpro Multi4 Charger requires a minimum pack voltage of 1.5V to activate charging. If an A123 pack is below this voltage, do not try to repair the pack by boosting voltage. Even if you manage to repair the pack, it will not have many cycles left and the charger will reject it for multiple reasons (as indicated by displayed safety codes).
Storing packs

- For best results, LiPo and A123 packs should be stored at 50% of capacity. Use the charger’s **LiPo All Brands Storage Charge** preset to prepare LiPo packs for storage, and the **A123 All Cptcy Storage Charge** to prepare A123 packs for storage.

**CAUTION:** Be sure the storage preset matches the battery chemistry. Using the incorrect preset will damage cells.

- LiPo packs charged to 100% should not be cooled below room temperature. Cells at 90% or less capacity can be cooled below 32°F (0°C).

How Auto Current Mode works

The Multi4 Charger’s Auto Current Mode (indicated by the charge rate Ax.0C) precisely monitors individual cell fuel levels (cell voltages) in a LiPo, Li-Ion or A123 pack. If the charger determines it is charging too fast, it slows down. Likewise, if it is charging too slow, it speeds up. The charger adjusts charge current at one minute intervals throughout the charge cycle.

When charging starts, it takes a short time for the charger to determine the correct parameters, so it may “hunt” for up to 30 minutes before it settles on the optimum current. This is normal, and doesn’t harm the pack. The longer the charge, the more accurate the calculation.

The plot below shows how Auto Current Mode adjusts the charger’s current when charging a 2.1Ah pack at 1.0C Auto. Initially, charge current is 500mA (this starting current is defined in the User Preset and is adjustable). Within a few minutes, the charger increases the current, and it eventually reaches 1.0C (1.9A in this example). This is slightly under the ideal 1.0C charge rate of 2.1A for this pack. Fuel rate Auto charging is intentionally calculated to be slightly conservative. Current drops as the pack reaches full charge (the charger changes to constant voltage mode). When charge current drops to about 0.05C, the pack is fully charged. If the cells are balanced, charging terminates. Termination settings are also controlled by the User Preset parameters.

With the 1.0C Auto Current Mode, a fully discharged pack is charged to its nominal capacity in about 60 to 80 minutes, depending on the state of imbalance. Auto Current Mode takes into account a pack’s starting charge level, so topping off a 50% discharged pack takes only about 30 minutes.
Using the Charge Control Software

The free Cellpro Multi4 Charge Control Software (CCS) gives you unparalleled ability to customize your charger. Using the CCS, you can

- Show, hide, reoder, save, load and share User Presets.
- Modify up to 80 parameters that define how a User Preset operates.
- For each User Preset, customize the content and order of screens—including the welcome screen and charging data screens—that appear in the charger’s LCD display.
- Monitor individual cells and the power supply during charging.
- Follow charging progress in real-time graphs.
- Update the charger’s firmware.
- Modify the charger’s display and audio settings.

Installing the Charge Control Software

For detailed information on installing the Cellpro Multi4 Charge Control Software, please visit the install page at

www.fmadirect.com:80/new_applications/software/Multi4_software.html

Launching the Charge Control Software

1. Start > All Programs > FMA Direct > Cellpro Multi4.

2. If your computer is connected to the Internet, the program will check to see whether a new version of the CCS and/or charger firmware is available. If new software/firmware is available, you will have the option to install the new version(s) or launch the CCS version you already have. (Remember, Internet Explorer must be the default browser for updates.)

3. If you download a new version of the CCS, it will automatically install and launch itself. (If a new firmware version was included in the download, see “Updating charger firmware,” later in this manual, for instructions.)

Connecting the charger to your computer

1. If the Charge Control Software isn’t running, launch it now.

   Note: If this is the first time you are connecting the charger to the PC, click Download USB Driver in the lower left corner of the CCS window. Follow onscreen instructions to install the driver for your PC interface (FUIM2 or FUIM3). Exit and relaunch the CCS.

2. Plug the FUIM2 or FUIM3’s 3-pin connector into the jack on the charger’s left side. The black wire should be toward the top of the charger’s panel.

3. Plug the FUIM2 or FUIM3’s USB connector into your computer.

4. Apply power to the charger.

5. Waiting to Start above the tabs confirms that the Charge Control Software and charger are communicating. (No Data from Charger indicates a communication problem.)
Monitoring charging operations

- When you start a charge at the charger, the CCS opens a dialog that enables you to save the charge graph.
  - **To save the graph:** Enter a name for the graph, navigate to the directory where you want to save it, then click **Save**. (If you keep the default name and location, the graph previously saved there will be overwritten.)
  - **To prevent saving of the graph:** Click **Cancel**.
- **To monitor cell voltages, total pack voltage and related charging parameters during charging:** Click the **Cells** tab.
- **To view charge parameter graphs:** **View > Graphs.** In the **Graph** window:
  - **To view volts for individual cells:** **View > Cell Volts.**
  - **To view total pack voltage:** **View > Pack Volts.**
  - **To view current:** **View > Amps.**
  - **To view fuel level:** **View > Fuel.**
  - **To print a graph:** **File > Print.**

Limiting charger input current

The charger will draw up to 5A to deliver its 4A maximum output current. The high input current is required when the input voltage must be boosted to drive packs having larger numbers of cells in series. The charger monitors input current from the power supply, and automatically reduces pack charge current if it determines that the power supply can’t keep up.

You can also manually limit the charger’s input current so the charger will not draw more power than the supply can provide. If you know your power supply is rated for 3A output, for example, you can limit the charger’s input current to 3A. This feature prevents damage to power supplies, such as bench supplies, having low to moderate output currents. (Be aware that limiting charger input current may increase pack charge times.) When the charger is powered from a high current source (such as a car battery), you can override manual current limiting to provide maximum pack charging current.

- **To monitor supply voltage:** Click the **Supply** tab.
- **To manually set input current limiting:**
  1. In the **Supply** tab, select the desired maximum current in the **Current Limit** dropdown list.
  2. Click the **Update Charger** button.
- **To override manual input current limiting at the field without using the Charge Control Software:**
  1. Press and hold the charger’s **Mode** button.
  2. Connect the charger’s input cables to the power source.
  3. When you see characters in the charger’s LCD display, release the **Mode** button.

  **Note:** If manual input current limiting is in effect, you must repeat this procedure each time you apply power to the charger if you want the charger to operate at full input current.

Setting charger options

1. Click the **Options** tab.
2. Set options as desired.
3. Click **Update Charger**.
**Updating charger firmware**

The Charge Control Software automatically checks for new firmware each time it is launched (assuming the computer is connected to the Internet). If new firmware is available, it is downloaded to your computer. When you are ready to update the charger:

1. Be sure the charger is connected to the computer, and is powered up.
2. Disconnect all packs from the charger.
3. In the Charge Control Software window, click the **Firmware** tab.
4. Select the firmware you want to download.
5. Click **Update Firmware**.
6. Wait—and do nothing to the PC, charger and interconnection—until updating is complete.

**IMPORTANT:** During firmware downloading, do not disconnect the charger from power, do not disconnect the charger from the computer, and do not exit the Charge Control Software.

**Configuring User Presets**

The Charge Control Software gives you almost total control over User Presets, including which ones are available in the charger, the order in which they are displayed, charging characteristics and the content and order of data screens displayed during charging.

1. Be sure the charger is connected to the computer, and is powered up.
2. In the Charge Control Software window, click the **Presets** tab. The left panel lists User Presets stored in the charger, and the right panel lists parameters and screens for the User Preset selected in the left panel.
3. Then:
   - **To change preset order:** In the left panel, drag the preset number up or down.
   - **To prevent a preset from being displayed in the charger:** Open the list next to the preset and click **Hide**.
   - **To configure a preset:** Select the preset in the left panel, then...
     - **To change charge characteristics:** Click the **Properties** tab in the right panel, then set options as needed.
     - **To change charge data screens:** Click the **Screens** tab in the right panel, then...
       - **To show or hide a data screen:** Select **Show** or **Hide** as appropriate.
       - **To change screen order:** Drag the screen number up or down.
4. Click **Update Charger**.

**Note:** The Charge Control Software performs extensive checks to make certain you have specified permissible charge parameters. If it finds errors, it will not download presets to the charger until the errors are corrected. Errors are displayed in the **Errors** tab. To correct an error, double-click the error in the **Errors** tab; you will be taken to the corresponding preset property, which you can change to an acceptable value.
Working with files

- **To save a single preset**: In the **Presets** tab, select the preset, then **File > Save Preset n to File**...
- **To load a single preset**: In the **Presets** tab, select the preset, then **File > Open File to Preset n**...
- **To back up all User Presets**: **File > Backup User Presets...**
- **To restore User Presets**: **File > Restore User Presets...**
- **To back up all Library Presets**: **File > Backup Library Presets...**
- **To restore all Library Presets**: **File > Restore Library Presets...**

<table>
<thead>
<tr>
<th>CCS file types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.pst</td>
<td>Single preset file</td>
</tr>
<tr>
<td>.psk</td>
<td>User Presets backup file</td>
</tr>
<tr>
<td>.lpb</td>
<td>Library Presets backup file</td>
</tr>
<tr>
<td>.cp4</td>
<td>Charge graph file</td>
</tr>
</tbody>
</table>

**Charger specifications**

**For battery types**
- Lithium Polymer (1s to 4s balanced, 1s to 2s unbalanced)*
- Lithium Ion (1s to 4s balanced, 1s to 2s unbalanced)
- Lithium Manganese (1s to 4s balanced, 1s to 2s unbalanced)
- A123 (2s to 4s balanced, 1s to 5s unbalanced)*
- NiCd (1s to 12s)
- NiMH (1s to 12s)
- 6V and 12V Lead Acid batteries

**Pack capacity**
- 5mAh to 32Ah (charge time limited to maximum of 8 hours)

**Input voltage**
- 10 to 16VDC, reverse polarity protected

**Input current**
- 5A maximum

**Power conversion**
- 125kHz switcher operating at 90% efficiency

**Output current**
- Up to 4A

**Cell balancing**
- To within 5mV for 2s to 4s LiPo, Li-Ion, Li-Mn or A123 packs

**Voltage calibration**
- Cell voltage measurements are factory calibrated to a standard traceable to NIST; calibration is to ±6mV

**Current calibration**
- Charge current is factory calibrated on a 4A standard; calibration is to ±1mA

**Measurement accuracy**
- Voltage: ±6mV
- Charge current: ±1%
- Capacity added to pack: ±1%
- Percent capacity (“Fuel”): ±5%

**Serial data output**
- 19.2kbps, 8 bits, 1 start bit, 1 stop bit, no parity

*charger can be used with balanced 2s to 4s packs having a node connector (an appropriate FMA adapter may be required)
Estimating performance factors

If you don’t have a way to directly measure your propulsion system’s electrical parameters, the Cellpro Multi4 Charger enables you to estimate them using before- and after-flight measurements.

1. Collect data
   a. Charge pack.
   b. When charging is finished, record **Fuel %** and **total pack voltage** (i.e. sum of cell voltages).
   c. Fly plane (or test on the ground). Record **flight time in minutes**.
   d. Connect pack to charger. Record **Fuel %** and **total pack voltage**.

2. Calculate performance factors

\[
\frac{(\text{Fuel } \% \text{ before flight}) - (\text{Fuel } \% \text{ after flight})}{100} \times (\text{Pack capacity, Ah}) = \text{Capacity consumed during flight, Ah}
\]

\[
\frac{(\text{Capacity consumed during flight, Ah}) \times 60}{(\text{Flight time, minutes})} = \text{Average current during flight, A}
\]

\[
\frac{(\text{Pack voltage before flight, V}) + (\text{Pack voltage after flight, V})}{2} = \text{Average voltage during flight, V}
\]

\[
(\text{Average voltage during flight, A}) \times (\text{Average current during flight, V}) = \text{Average power during flight, Watts}
\]

\[
\frac{(\text{Average power during flight, Watts})}{(\text{Model weight, pounds})} = \text{Watts per pound}
\]

The “LiPo Performance Estimator” spreadsheet, which simplifies these calculations, can be downloaded from [www.fmadirect.com/tech_data/techdocs/](http://www.fmadirect.com/tech_data/techdocs/).

3. Evaluate results

- **Average current during flight** gives you a rough idea whether system components—ESC, motor, connectors and wiring—are operating within their current ratings. Keep in mind that peak current during flight may greatly exceed the average current you calculated.

- **Watts per pound** is an approximate indicator of aircraft performance (other factors influencing performance include lift, drag and motor type). Here are some guidelines:
  - 25 to 30 watts per pound: level flight.
  - 40 to 50 watts per pound: take off from smooth surface, climb.
  - 50 to 75 watts per pound: take off from grass, sport aerobatics.
  - 75 to 125 watts per pound: pattern aerobatics.
  - Over 125 watts per pound: 3D.

**Tip:** For more direct electrical measurements, consider these FMA products:
- 60A Current Shunt (Model DVM-SHUNT-60)
- Digital Multimeter (Model DVM-VC890D)
Operating errors appear as safety codes in the display. If possible, correct the error. If errors continue, contact FMA Customer Service.

<table>
<thead>
<tr>
<th>Code</th>
<th>Cause</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Increase Supply</td>
</tr>
<tr>
<td>2</td>
<td>Supply &lt;10 Volts</td>
</tr>
<tr>
<td>3</td>
<td>Supply &gt;16 Volts</td>
</tr>
<tr>
<td>4</td>
<td>Supply Unstable</td>
</tr>
<tr>
<td>5</td>
<td>Prset not for 4S</td>
</tr>
<tr>
<td>6</td>
<td>Bad Preset Versn</td>
</tr>
<tr>
<td>7</td>
<td>Reduce NiCd Amps</td>
</tr>
<tr>
<td>8</td>
<td>Series Chrgrs?</td>
</tr>
<tr>
<td>9</td>
<td>P. Library Empty</td>
</tr>
<tr>
<td>10</td>
<td>Low Voltage Cell</td>
</tr>
<tr>
<td>11</td>
<td>Preset is Hidden</td>
</tr>
<tr>
<td>12</td>
<td>Reverse Polarity</td>
</tr>
<tr>
<td>13</td>
<td>Preset is Empty</td>
</tr>
<tr>
<td>14</td>
<td>MODE not Pressed</td>
</tr>
<tr>
<td>15</td>
<td>System Softstart</td>
</tr>
<tr>
<td>16</td>
<td>Preset is Locked</td>
</tr>
<tr>
<td>17</td>
<td>Ch1 No Add Up</td>
</tr>
<tr>
<td>18</td>
<td>Max Cells Error</td>
</tr>
<tr>
<td>19</td>
<td>No Pack</td>
</tr>
<tr>
<td>20</td>
<td>Bad Cell Count</td>
</tr>
<tr>
<td>21</td>
<td>Bad P. Ram Check</td>
</tr>
<tr>
<td>22</td>
<td>Cells Exceeded</td>
</tr>
<tr>
<td>23</td>
<td>Un-Bal. Only</td>
</tr>
<tr>
<td>24</td>
<td>Charge Timeout</td>
</tr>
<tr>
<td>25</td>
<td>Cell Cnt Changed</td>
</tr>
<tr>
<td>26</td>
<td>NiCd Detected</td>
</tr>
<tr>
<td>27</td>
<td>Cells no Correct</td>
</tr>
<tr>
<td>28</td>
<td>Cell OverVoltage</td>
</tr>
<tr>
<td>78</td>
<td>High Voltage When Off</td>
</tr>
<tr>
<td>79</td>
<td>CH1 Cells Out of Range</td>
</tr>
<tr>
<td>88</td>
<td>Checkpack1 Cell V Out of Range</td>
</tr>
<tr>
<td>90</td>
<td>Unknown Screen Number</td>
</tr>
<tr>
<td>92</td>
<td>Mux Number Error</td>
</tr>
<tr>
<td>93</td>
<td>Calibration Checksum Bad</td>
</tr>
<tr>
<td>94</td>
<td>Bad EEPROM Write</td>
</tr>
<tr>
<td>95</td>
<td>Bypass Overvolt</td>
</tr>
<tr>
<td>96</td>
<td>PWM Ratio Too High</td>
</tr>
<tr>
<td>97</td>
<td>Bad FET Supply Voltage</td>
</tr>
<tr>
<td>98</td>
<td>Charger Overcurrent</td>
</tr>
<tr>
<td>99</td>
<td>Bad Mode Number</td>
</tr>
<tr>
<td>100</td>
<td>Temp out of Range</td>
</tr>
<tr>
<td>105</td>
<td>Preset not validated</td>
</tr>
<tr>
<td>106</td>
<td>Preset number out of range</td>
</tr>
<tr>
<td>107</td>
<td>Charge Timeout out of range</td>
</tr>
<tr>
<td>108</td>
<td>Preset loaded while charging</td>
</tr>
<tr>
<td>109</td>
<td>Charge Termination Unknown</td>
</tr>
<tr>
<td>111</td>
<td>Preset Cell OverVolts too High</td>
</tr>
<tr>
<td>112</td>
<td>Options Checksum is BAD</td>
</tr>
<tr>
<td>113</td>
<td>Charge PWM not regulating</td>
</tr>
<tr>
<td>114</td>
<td>Bad Preset Flash Checksum while running</td>
</tr>
<tr>
<td>115</td>
<td>Bad Preset Flash Checksum on Start</td>
</tr>
<tr>
<td>116</td>
<td>Bad Preset Ram Checksum on Start</td>
</tr>
<tr>
<td>117</td>
<td>Bad Segment Checksum on Start</td>
</tr>
<tr>
<td>118</td>
<td>Bad Segment Checksum while running</td>
</tr>
<tr>
<td>120</td>
<td>Lithium Cell Count not Verified</td>
</tr>
<tr>
<td>121</td>
<td>Shunt FET off while CHG/DSCH</td>
</tr>
<tr>
<td>122</td>
<td>Unknown Chemistry</td>
</tr>
<tr>
<td>123</td>
<td>No Charge Screens to Show</td>
</tr>
<tr>
<td>124</td>
<td>Bad Run Screen Number</td>
</tr>
<tr>
<td>125</td>
<td>Cell Count is Zero</td>
</tr>
<tr>
<td>126</td>
<td>Discharge Mode not set to Balancer</td>
</tr>
<tr>
<td>127</td>
<td>Discharge Mode Timeout</td>
</tr>
<tr>
<td>128</td>
<td>Peek Detect set past 15 min</td>
</tr>
<tr>
<td>129</td>
<td>NiCd Chem must use FallBack</td>
</tr>
<tr>
<td>130</td>
<td>Lith Chem must not use FallBack</td>
</tr>
<tr>
<td>131</td>
<td>Oscillator Calibration Erased</td>
</tr>
</tbody>
</table>
Quick start for the Cellpro Multi4 Charger

Assumes Auto Start is OFF. Refer to manual for complete operating details.

A. Connect charger to a 12V to 16V (maximum), 5A power source.
B. Welcome screen (Cellpro Multi4) times out, then charger displays Preset Menu.
C. In Preset Menu, press Mode button to display User Preset for pack you want to charge.
D. Connect pack to charger.
E. Press and hold Mode button. When you see START CHARGE, release Mode button. Display briefly shows CHECKING PACK.
F. Next screen displays preset’s chemistry and prompts you to verify it is same as pack’s chemistry. This is a safety check.
   ■ If displayed chemistry matches pack chemistry, press Mode button to start charging. Go to step G.
   or
   ■ If displayed chemistry does not match pack chemistry, do nothing. Screen will time out and Preset Menu will be displayed. Go to step C.
G. During charging:
   ■ Press Mode button to view charging data screens.
   ■ To stop charging:
     a. Press and hold Mode button to see STOP CHARGE? >No.
     b. Press Mode button to see STOP CHARGE? >Yes. Press and hold Mode button.
     c. When you see CHARGER STOPPED, press Mode button to see Preset Menu (step C).
H. When charging is complete, charger beeps three times repeatedly and displays ELAPSED [time] / [chemistry] DONE. Press Mode button to review charging data screens.
I. Disconnect pack from charger. Display shows PACK REMOVED.
J. Press Mode button to return to Preset Menu.

FMA limited warranty

FMA, Inc. warrants this product to be free of manufacturing defects for the term of one year from the date of purchase. Should any defects covered by this warranty occur, the product shall be repaired or replaced with a unit of equal performance by FMA or an authorized FMA service station.

Limits and exclusions

This warranty may be enforced only by the original purchaser, who uses this product in its original condition as purchased, in strict accordance with the product’s instructions. Units returned for warranty service to an FMA service center will be accepted for service when shipped postpaid, with a copy of the original sales receipt or warranty registration form, to the service station designated by FMA.

This warranty does not apply to:
■ Consequential or incidental losses resulting from the use of this product.
■ Damage resulting from accident, misuse, abuse, neglect, electrical surges, reversed polarity on connectors, lightning or other acts of God.
■ Damage from failure to follow instructions supplied with the product.
■ Damage occurring during shipment of the product either to the customer or from the customer for service (claims must be presented to the carrier).
■ Damage resulting from repair, adjustment, or any alteration of the product by anyone other than an authorized FMA technician.
■ Installation or removal charges, or damage caused by improper installation or removal.

Call (301) 829-5533 for more information about service and warranty repairs.